
® ®Moving between Microsoft  Word and WordPerfect , 
® ®Microsoft  Excel and Quattro Pro , 

® ® ™and Microsoft  PowerPoint  and Presentations



Product specifications, pricing, packaging, technical support and information (“Specifications”) refer to the United States retail English version only. 

The United States retail version is available only within North America and is not for export. Specifications for all other versions (including language 

versions and versions available outside of  North America) may vary.

INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, SATISFACTORY 

QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF 

TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED 

OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 

INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS 

OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS 

BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR 

ANY CLAIMS MADE BY ANY THIRD PARTY. COREL’S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE 

COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR 

LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT 

APPLY TO YOU.

© 2003 Corel Corporation. All rights reserved. Corel, Grammar As-You-Go, Presentations, Quattro Pro, QuickCorrect, QuickWords, QuickFinder, 

SpeedFormat, Spell-As-You-Go, TextArt, WordPerfect and the Corel logo are trademarks or registered trademarks of  Corel Corporation and/or its 

subsidiaries in Canada, the United States and/or other countries. Grammatik is a registered trademark of  Novell, Inc. Microsoft, MS-DOS, 

PowerPoint, Visual Basic and Windows are registered trademarks of  Microsoft Corporation in the United States and/or other countries. Other 

product, font and company names and logos may be trademarks or registered trademarks of  their respective companies. 

THIS COMPARISON IS FOR RELEASE IN NORTH AMERICA ONLY. DO NOT COPY OR DISTRIBUTE OUTSIDE NORTH AMERICA.

References to Microsoft Word and Microsoft Excel are to the latest version of  Microsoft Office XP as of  April 1, 2003. Microsoft PowerPoint 

references are to Microsoft PowerPoint 97. The information on Microsoft Word, Microsoft Excel and Microsoft PowerPoint contained herein has 

been derived from the application and its online help. Product specifications, pricing, packaging, technical support and information (“Specifications”) 

refer to the United States retail English version only. The United States retail English version is available only within North America and is not for 

export. Specifications for all other versions (including language versions and version available outside North America) may vary. All Specifications, 

claims, features, representations and/or comparisons provided are correct to Corel’s best knowledge at the date of  publication, April 1, 2003. 

However, because the software programs referred to herein are complex and may be upgraded from time to time, some descriptions may become 

inaccurate. We recommend that you do not rely solely on this document in evaluating these programs, but that you carefully review the current 

Specifications of  each product to weigh the features and benefits that apply to a particular task. If  you know of  any inaccuracy within this document, 

please write to Corel Corporation, WordPerfect Product Management team, 1600 Carling Ave., Ottawa, Ontario  K1Z 8R7.

WordPerfect Office 11

w h i t e  p a p e r



Contents

Introduction .................................................................................................................5

Moving Between Microsoft Word and WordPerfect ......................................................6

Opening Microsoft Word documents ...................................................................6

Saving WordPerfect documents as Microsoft Word documents ............................7

Enabling the Microsoft Word menu bar ...............................................................7

Using Microsoft Word shortcut keys in WordPerfect.............................................8

Comparing Microsoft Word and WordPerfect features.......................................10

Customizing WordPerfect ..................................................................................12

Publishing to PDF in WordPerfect. ......................................................................13

Moving Between Microsoft Excel and Quattro Pro ......................................................15

Opening Microsoft Excel documents ..................................................................15

Saving Quattro Pro documents as Microsoft Excel documents ............................15

Enabling Microsoft Excel menus and tabs in Quattro Pro ....................................16

Microsoft Excel analysis tools not imported by Quattro Pro.................................17

Microsoft Excel cell attributes and styles imported by Quattro Pro ......................17

Microsoft Excel formulas and functions imported by Quattro Pro .......................18

Microsoft Excel functions not supported by Quattro Pro.....................................19

Microsoft Excel functions supported by Quattro Pro ...........................................20

Microsoft Excel print options, windows, and charts 
imported by Quattro Pro ....................................................................................23

Microsoft Excel spreadsheet data imported by Quattro Pro.................................24

Spreadsheet objects transferred between 
Microsoft Excel and Quattro Pro........................................................................ 25

Moving Between Microsoft PowerPoint and Presentations ...........................................26

Opening Microsoft PowerPoint documents ........................................................26

Saving Presentations documents as Microsoft PowerPoint documents ................27

Comparing Presentations and Microsoft PowerPoint menu features ...................32

Using Microsoft PowerPoint shortcut keys in Presentations.................................56

Customizing Presentations .................................................................................49

Publishing to PDF in Presentations......................................................................51

WordPerfect Office 11

w h i t e  p a p e r



Introduction

This document is designed to help users make the transition from Microsoft® Word and
Microsoft® Excel to WordPerfect® 11 and Quattro Pro® 11. The document uses
comparative tables to illustrate key differences between the applications, and also provides
basic procedures to help smooth your transition.

WordPerfect and Quattro Pro have been designed to be as compatible as possible with
Microsoft Word and Microsoft Excel. You can open, import, export, and save Microsoft
Word and Microsoft Excel files easily, reducing or eliminating many of the difficulties that
can arise when switching applications. 
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Moving Between Microsoft® Word and
WordPerfect®

WordPerfect 11 makes it easy for you to convert Microsoft Word files to WordPerfect
format, open Microsoft Word documents in WordPerfect, and save WordPerfect documents 
as Microsoft Word files. If you are moving from Microsoft Word, you need to know which
features of WordPerfect have different names. Because Microsoft Word and WordPerfect
share basic formatting features, essential layouts, and many of the same menu options, you
can create Microsoft Word documents and then easily import files into WordPerfect.

Opening Microsoft® Word documents
You can open the following Microsoft Word file formats in WordPerfect:

• Microsoft Word 1.0 for MS-DOS®

• Microsoft Word 1.1 for MS-DOS

• Microsoft Word 1.2 for MS-DOS

• Microsoft Word 2.0 for MS-DOS

• Microsoft Word 4.0 for MS-DOS

• Microsoft Word 5.0 for MS-DOS

• Microsoft Word 5.5 for MS-DOS

• Microsoft Word 6.0 for Windows®

• Microsoft Word 7.0 (Microsoft® Office 95)

• Microsoft Word 97

• Microsoft Word 2000

• Microsoft Word 2002 (Microsoft Office XP)

To open a Microsoft Word document

1 Click File � Open.

2 Choose the drive and folder where the file is stored. 

3 Click a filename. 
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4 Click Open.

To insert a Microsoft Word document into a WordPerfect file

1 Click Insert � File.

2 Choose the drive and folder where the file is stored. 

3 Click a filename.

4 Click Insert.

Saving WordPerfect® documents as 
Microsoft® Word documents
You can save WordPerfect documents as Microsoft Word documents. This ensures that
your WordPerfect files will transfer virtually seamlessly to different versions of Microsoft
Word.  

To save a WordPerfect document as a Microsoft Word document

1 Click File � Save as.

2 Choose the drive and the folder where you want to save the file.

3 Type the filename in the Filename list box.

4 Choose a version of Microsoft Word from the File type list box.

5 Click Save.  

Enabling the Microsoft® Word menu bar
WordPerfect gives you the option to change the user interface (UI) to include the Microsoft
Word menu bar. 

To enable the Microsoft Word menu bar

1 Click View � Toolbars.

2 Enable the Microsoft Word 2002 check box. 
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Using Microsoft® Word shortcut keys in
WordPerfect®

The following table lists the Microsoft Word shortcut keys and the WordPerfect keyboard
equivalents. You can customize your shortcut keys to reflect Microsoft Word or
WordPerfect settings. 

Microsoft® Word
shortcut keys

WordPerfect® command WordPerfect® 11 shortcut keys

Ctrl + E Align center Shift + F7

Ctrl + B Bold, turn on/turn off Ctrl + B

Ctrl + F4 Close document Ctrl + F4

Ctrl + C
Copy the selection to the
Clipboard

Ctrl + C

Alt + F4 Exit Alt + F4

Ctrl + D Font, change F9

F7
Grammar, check and
correct

Alt + Shift + F1

Ctrl + Enter Hard page break Ctrl + Enter

Enter Hard return Enter

F1 Help F1

Ctrl + Hyphen Hyphen, hard Ctrl + Hyphen

Ctrl + Shift +
Hyphen

Hyphen, soft Ctrl + Shift + Hyphen

Ctrl + M
Indent current paragraph
one tab stop

F7

Ctrl + I Italic, turn on/turn off Ctrl+ I

Ctrl + V
Insert Clipboard contents
at the cursor

Ctrl + V

Ctrl + G
Jump to a specified place in 
the document

Ctrl + G

Ctrl + E Justify center Ctrl + E
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Microsoft® Word
shortcut keys

WordPerfect® command WordPerfect® 11 shortcut keys

Ctrl + J Justify full Ctrl + J

Ctrl + L Justify left Ctrl + L

Ctrl + R Justify right Ctrl + R

Shift + Enter Line break Ctrl + Shift + L

Ctrl + T
Margin release (hanging
indent)

Ctrl + F7

Ctrl + Home
Move the cursor to the
beginning of the document

Ctrl + Home

Home
Move the cursor to the
beginning of a line

Home

Page down
Move the cursor to the
bottom of the screen

Page down

Up Arrow Move one cell up in a table Alt + Up Arrow

Down Arrow
Move one cell down in a
table

Alt + Down Arrow

Right Arrow or
Tab

Move one cell right in a
table

Alt + (Right Arrow or Tab)

Left Arrow or Tab Move one cell left in a table Alt + (Left Arrow or Tab)

Right Arrow
Move one column to the
right

Alt + Right Arrow

Left Arrow
Move one column to the
left

Alt + Left Arrow

Ctrl + X
Move selection to the
Clipboard

Ctrl + X

Ctrl + N New document Ctrl + Shift + N

Ctrl + Enter New page Ctrl + Enter

Ctrl + O Open document Ctrl + O

Ctrl + P Print Ctrl + P

Ctrl + S Save Ctrl + S
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Microsoft® Word
shortcut keys

WordPerfect® command WordPerfect® 11 shortcut keys

F12 Save as F3

Ctrl + F Search (forward) Ctrl + F

Ctrl + Shift+ F Search (backward) Ctrl + Shift + F

F7 Spelling, check and correct Ctrl + F1

Shift + F7 Open thesaurus ALT + F1

Ctrl + U Underline, turn on/turn off Ctrl + U

Insert Typeover Insert

Ctrl + Z Undo Ctrl + Z 

Ctrl + Y Undo reverse last Ctrl + Shift+ Z

Comparing Microsoft® Word and WordPerfect®

features
The following table lists the features in Microsoft Word that have different names in
WordPerfect.

Microsoft® Word feature WordPerfect® 11 feature

Annotation Comment

AutoCorrect QuickCorrect™

AutoShapes Shapes

AutoText QuickWords™

Automatic save Backup

Break New page

Bullets and numbers Bulleted, numbered, and alphabetical lists

Change case Convert case

Character Font appearance

Charting Chart

Compare versions Document review
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Microsoft® Word feature WordPerfect® 11 feature

Create envelope Envelopes

Customize Settings

Drawing Draw

Find file QuickFinder™

Footers Headers/footers

Frame Graphics

Full screen Hide bars

Grammar Grammatik®

Grammar as you type Grammar As-You-Go™

Headers Headers/footers

Indentation Indent

Index and tables Reference

Keep lines together Keep text together

Keep with next Conditional end of page

Merge documents or Mail merge Merge

Merge cells Join

Options Settings

Page alignment Center page

Paragraph alignment Justification

Protect document Keep text together

Right-aligned text Flush right

Sorting Sort

Spelling Spelling checker

Spelling as you type Spell-As-You-Go™

Summary info Document summary

Table AutoFormat SpeedFormat™

Tabs Tab set
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Microsoft® Word feature WordPerfect® 11 feature

Text direction Rotate text

Track changes Document review

Vertical alignment Center page

WordArt TextArt®

Word count Properties

Customizing WordPerfect® 
One of the key strengths of WordPerfect is its ease of customization. You can customize
virtually any element of WordPerfect to ensure that it fits your working style and needs. 

To customize WordPerfect 11

1 Click Tools � Settings.

2 Choose an element to be customized from the Settings dialog box.
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To customize toolbars, property bars, menus, or keyboards

1 Click Tools � Settings � Customize.

2 Choose an element to be customized from the dialog box that appears.

Publishing to PDF in WordPerfect®

WordPerfect features an integrated engine that lets you publish a document to Portable
Document Format (PDF) so that it can be distributed across multiple platforms and read by 
virtually anyone. You can choose common PDF styles and compression methods, add
bookmarks, and more. And, with support for Adobe Acrobat Reader 5.0, PDF
compatibility will never be a problem. 

To publish the active document to PDF 

1 Click File � Publish to PDF.

2 Click the General tab.

3 Choose Browse from the Filename list box.

4 Choose the drive and folder where you want to save the file.
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5 Type the filename in the Filename box.

6 Click Save. 

7 In the Export range area, enable one or more of the following options:

• Full document — publishes the entire file

• Current page — publishes the active page only

• Pages — publishes a portion of the file

• Selection — publishes selected text

8 Choose a style from the PDF style list box.

9 Click OK. 
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Moving Between Microsoft® Excel and
Quattro Pro®

You can open Microsoft Excel workbooks in Quattro Pro without truncating data. Quattro 
Pro supports many of the features of Microsoft Excel and translates most Microsoft Excel
formats, navigational tools, print options, formulas, and spreadsheet functions.
Occasionally, some information in a workbook cannot be imported or exported or may not 
display in the same way after the conversion process.

Opening Microsoft® Excel documents
You can open Microsoft Excel version 3, 5, 7, 97, 2000, and 2002 workbooks in Quattro
Pro. If you modify the workbook, you can save it as a Quattro Pro notebook so that you
don't lose Quattro Pro formulas or features not supported in Microsoft Excel.

Microsoft Excel workbooks that contain custom spreadsheet names may not open in
Quattro Pro if characters used in the names are not recognized by Quattro Pro. If this
happens, Quattro Pro displays a dialog box warning you about the invalid spreadsheet
name. You can change the spreadsheet name to make it compatible with Quattro Pro.

To open a Microsoft Excel workbook in Quattro Pro

1 Click File � Open.

2 Choose the drive and folder where the workbook is stored.

3 Double-click the workbook’s filename. 

Saving Quattro Pro® documents as
Microsoft® Excel documents
You can save a Quattro Pro notebook as a Microsoft Excel file; however, some file format
features unique to Quattro Pro may be lost.

To save a Quattro Pro notebook as a Microsoft Excel file

1 Click File � Save as.

2 Choose the drive and folder where you want to save the file.

3 Type a filename in the Filename box.

4 Choose a Microsoft Excel file type from the File type list box.
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Enabling Microsoft® Excel menus and tabs in
Quattro Pro®

You can use Microsoft Excel 2002 menus and tabs in Quattro Pro. This lets you work in a
familiar environment until you are accustomed to the Quattro Pro menu structure.

You can change spreadsheet tabs in a Quattro Pro notebook to adopt the Microsoft Excel
2002 spreadsheet naming conventions.

To use Microsoft Excel 2002 menus and tabs in Quattro Pro

1 Click Tools � Settings. 

2 Click Workspaces.

3 Enable the Microsoft Excel check box in the Workspaces list.

To switch to the Microsoft Excel naming convention for spreadsheet tabs

1 Click Tools � Settings.

2 In the list of categories, double-click Workspace, Application, and click Compatibility.

3 In the Sheet tab display area, enable the Display as numbers check box. 
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Microsoft® Excel analysis tools not imported by
Quattro Pro®

Quattro Pro cannot import the following Microsoft Excel analysis tools:

Scenario Manager data — data is ignored in Quattro Pro

Solve information — information is not imported to Quattro Pro Optimizer

Microsoft® Excel cell attributes and styles
imported by Quattro Pro® 
When you open a Microsoft Excel file in Quattro Pro, most cell properties, styles, and
named blocks are imported and translated automatically.

Cell properties and styles

Styles are imported from and exported to Microsoft Excel files. When importing files to
Quattro Pro, the style names and formatting are translated into Quattro Pro styles. The
formatting includes the following cell attributes:

• font (style, size, bold, italic, underline, color)

• line drawing (single, double, thick, color)

• cell width

• numeric format (transfers to the most closely resembled format)

• row heights (can be imported into Quattro Pro, but cannot be exported into Microsoft 
Excel)

Named blocks

Quattro Pro imports Microsoft Excel named ranges, including 2D and 3D ranges. Quattro
Pro also exports its named 2D and 3D ranges into Microsoft Excel spreadsheets.

Shrink to fit

The Microsoft Excel Shrink to fit feature is not supported by Quattro Pro.

Currency formats

Not all Microsoft Excel currency formats are supported by Quattro Pro; conversely, not all
Quattro Pro currency formats are supported by Microsoft Excel.
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Microsoft® Excel formulas and functions
imported by Quattro Pro®

Quattro Pro maps as many Microsoft Excel formulas to spreadsheet functions as possible
when it opens a Microsoft Excel file. Those without a Quattro Pro equivalent are
translated as values, and the background color of the cell changes to red. When you save a
file in a Microsoft Excel format, Quattro Pro translates spreadsheet functions to the nearest 
equivalent Microsoft Excel function. 

Array formulas

Array formulas are not imported.

Hidden formulas

When importing Microsoft Excel files, Quattro Pro converts Microsoft Excel hidden
formulas to a protected cell with the format hidden. Quattro Pro does not, however, export 
hidden formulas.

User-defined functions

When Quattro Pro opens Microsoft Excel spreadsheets containing user-defined functions,
they are converted to values, and the cells are shaded red. Quattro Pro does not export
user-defined functions.
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Microsoft® Excel functions not supported by
Quattro Pro®

The following Microsoft Excel functions are not supported by Quattro Pro. Only the values
are imported, and the cells are shaded red to indicate that the formula was not imported.
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AMORDEGRC

AMORLINC

AREAS

BIN2DEC

BIN2HEX

BIN2OCT

COMBIN

DCOUNT

DEC2BIN

DEC2HEX

DEC2OCT

DGET

DPRODUCT

EDATE

ERROR.TYPE

FORECAST

FVSCHEDULE

HEX2BIN

HEX2DEC

HEX2OCT

HLOOKUP

INFO

ISBLANK

ISREF

LOOKUP

OCT2BIN

OCT2DEC

OCT2HEX

SEARCH

SUMPRODUCT

TEXT

VLOOKUP



ABS

ACCRINT

ACCRINTM

ACOS

ACOSH

ADDRESS

AND

ASIN

ASINH

ATAN

ATAN2

ATANH

AVERAGE

BESSELI

BESSELJ

BESSELK

BESSELY

BETADIST

BETAINV

CEILING

CELL

CHAR

CHIDIST

CHIINV

CHITEST

CHOOSE

CLEAN

CODE

COLUMN

COLUMNS

COMPLEX

CONCATENATE

CONFIDENCE

CONVERT

CORREL

COS

COSH

COUNT

COUNTA

COUNTIF

COUNTBLANK

COUPDAYBS

COUPDAYS

COUPDAYSNC

COUPNCD

COUPNUM

COUPPCD

COVAR

CRITBINOM

CUMIPMT

CUMPRINC

DATE

DATEVALUE

DAVERAGE

DAY

DAYS360

DB

DCOUNTA

DCOUNT

DDB

DEGREES

DELTA

DEVSQ

DISC

DMAX

DMIN

DOLLAR

DOLLARDE

DOLLARFR

DSTDEV

DSTDEVP

DSUM

DURATION

DVAR

DVARP

EFFECT

EOMONTH

ERF

ERFC

EVEN

EXACT

EXP

EXPONDIST

FACT

FACTDOUBLE

FALSE

FDIST

FIND

FINV

FISHER

FISHERINV

FIXED

FLOOR

FREQUENCY

FTEST

FV

GAMMADIST

GAMMAINV

GAMMALN

GCD

GEOMEAN

GESTEP

GROWTH

HARMEAN

HOUR

HYPGEOMDIST

IF

IMABS

IMAGINARY

IMARGUMENT

IMCONJUGATE

IMCOS

IMDIV

IMEXP

IMLN

IMLOG10

WordPerfect Office 11 19

w h i t e  p a p e r

Microsoft® Excel functions supported by
Quattro Pro®



IMLOG2

IMPOWER

IMPRODUCT

IMREAL

IMSIN

IMSQRT

IMSUB

IMSUM

INDEX

INDIRECT

INT

INTERCEPT

INTRATE

IPMT

IRR

ISERR

ISERROR

ISEVEN

ISLOGICAL

ISNA

ISNONTEXT

ISNUMBER

ISODD

ISTEXT

KURT

LARGE

LCM

LEFT

LEN

LINEST

LN

LOG

LOG10

LOGEST

LOGINV

LOGNORMDIST

LOWER

MATCH

MAX

MDETERM

MDURATION

MEDIAN

MID

MIN

MINUTE

MINVERSE

MIRR

MMULT

MOD

MODE

MONTH

MROUND

MULTINOMIAL

N

NA

NEGBINOMDIST

NETWORKDAYS

NOMINAL

NORMDIST

NORMINV

NORMSDIST

NORMSINV

NOT

NOW

NPER

NPV

ODD

ODDFPRICE

ODDFYIELD

ODDLPRICE

ODDLYIELD

OFFSET

OR

PEARSON

PERCENTILE

PERCENTRANK

PERMUT

PI

PMT

POISSON

POWER

PPMT

PRICE

PRICEDISC

PRICEMAT

PROB

PRODUCT

PROPER

PV

QUARTILE

QUOTIENT

RADIANS

RAND

RANDBETWEEN

RANK

RATE

RECEIVED

REPLACE

REPT

RIGHT

ROMAN

ROUND

ROUNDDOWN

ROUNDUP

ROW

ROWS

RSQ

SECOND

SIGN

SIN

SINH

SKEW
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SLN

SLOPE

SMALL

SQRT

SQRTPI

STANDARDIZE

STDEV

STDEVP

STEYX

SUBSTITUTE

SUBTOTAL

SUM

SUMIF

SUMSQ

SUMX2MY2

SUMX2PY2

SUMXMY2

SYD

T

TAN

TANH

TBILLEQ

TBILLPRICE

TBILLYIELD

TDIST

TIME

TIMEVALUE

TINV

TODAY

TRANSPOSE

TREND

TRIM

TRIMMEAN

TRUE

TRUNC

TTEST

TYPE

UPPER

VALUE

VAR

VARP

VDB

WEIBULL

WEEKDAY

WORKDAY

XIRR

XNPV

YEAR

YEARFRAC

YIELD

YIELDDISC

YIELDMAT

ZTEST
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Microsoft Excel print options, windows, and
charts imported by Quattro Pro®

When you import Microsoft Excel files, most print options, window configurations, and
charts translate seamlessly into Quattro Pro. When exporting a Quattro Pro notebook to a
Microsoft Excel file, charts are converted to the nearest Microsoft Excel equivalent.

Print options

The following print options are imported into Quattro Pro from Microsoft Excel files:

• orientation

• margins (top, left, right, bottom)

• header size (inches)

• footer size (inches)

• header text

• footer text

• print grid lines

Chart types

Microsoft Excel charts that match Quattro Pro chart types convert; otherwise, Quattro Pro 
converts the Microsoft Excel chart to the Quattro Pro chart that it most closely resembles,
adding properties where it can to make the chart look as much as possible like the
Microsoft Excel chart. Bitmaps and textures added to Microsoft Excel charts do not
convert. They become solid colors in Quattro Pro.

Microsoft Excel chart types not supported by Quattro Pro

• stacked line chart and 100% stacked line chart

• bar of pie chart and pie of pie chart

• 100% stacked area chart and 3D 100% stacked area chart

• no direct support for color radar chart

• no direct support for contour chart

• no direct support for scatter chart

• no direct support for multiple-series donut chart

Microsoft Excel chart attributes not supported by Quattro Pro

• fill settings for XY titles
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• title — vertical alignment and orientation

• minor gridlines

• limited support for bar overlapping

• limited pattern support for axis or gridlines

• limited support for gradient fill styles

• limited support for legend positioning

Microsoft Excel 2002 chart items possibly missing when converting to Quattro Pro

When opening Microsoft Excel 2002 workbooks in Quattro Pro, embedded charts may
display problems. The data is converted, but the following items may be missing from the
chart:

• any lines, labels, or attributes related to the secondary y-axis

• both the primary and secondary y-axis scales

Microsoft® Excel spreadsheet data imported by
Quattro Pro®

Quattro Pro reads Microsoft Excel version 3, 5, 7, 97, 2000, and 2002 workbook files and
imports the following Microsoft Excel data:

• values and labels

• most cell formatting

• embedded charts

• links to different workbooks or files

• most functions

• arithmetic formulas

• chart spreadsheets (converted to floating graphs)

• OLE objects contained in Microsoft Excel spreadsheets

Hyperlinks

Hyperlinks saved in Microsoft Excel files do not work in Quattro Pro.

Spreadsheet and file types

Quattro Pro imports and exports only Microsoft Excel workbook files. In Microsoft Excel
version 5 and later, this includes multiple-spreadsheet support. Quattro Pro does not
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recognize Microsoft Excel chart pages or macro pages, chart files (.xlc), templates (.xlt),
add-ins (.xla, .xll), or toolbars (.xlb).

Password protection

Microsoft Excel password protection is not supported. Quattro Pro displays a warning if a
user attempts to open a protected Microsoft Excel file.

Microsoft® Visual Basic® for Applications

Quattro Pro cannot read, write, or interpret Visual Basic for Applications (VBA) scripts
written from within Microsoft Excel. Quattro Pro cannot translate its own VBA scripts
into Microsoft Excel–compatible scripts.

Microsoft® Excel macros

Quattro Pro does not support Microsoft Excel macros.

Microsoft® Excel functions

Quattro Pro converts any Microsoft Excel function that it does not support to a value, and
shades it red. Before converting a Microsoft Excel file to Quattro Pro, make sure no cells in 
the Microsoft Excel file are shaded red or contain red text.

If Quattro Pro does not understand any of the Microsoft Excel commands, the commands
and any associated comments appear as comments in the converted file.

Spreadsheet objects transferred between
Microsoft® Excel and Quattro Pro®

With some exceptions, OLE objects and other objects such as graphs can be transferred
between Microsoft Excel and Quattro Pro.

OLE 2.0 links and objects

Quattro Pro loads OLE 2.0 links embedded in a Microsoft Excel file. However, Quattro
Pro does not export OLE 2.0 links when saving to a Microsoft Excel format.

Quattro Pro imports OLE 2.0 objects embedded in Microsoft Excel spreadsheets. However, 
Quattro Pro does not export OLE 2.0 objects when saving to a Microsoft Excel format.

Inserted graphs

Quattro Pro maps an inserted Microsoft Excel graph to the nearest Quattro Pro style.
Quattro Pro also exports its inserted graphs, mapping them to the nearest match in
Microsoft Excel.
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Draw layer objects

Draw layer objects are imported into the draw layer in Quattro Pro. Draw layer objects
include arrows, text boxes, buttons, line segments, rectangles, filled rectangles, rounded
rectangles, and ellipses. Polygons and freehand drawings are not imported.

In situations where there is no comparable spreadsheet, AutoShape, shape, or drawing tool
within Microsoft Excel or Quattro Pro, the shape is replaced with the best possible fit or is
deleted. Text callout shapes will lose the text within them on import.

Draw layer objects in Quattro Pro are not exported to Microsoft Excel files.

Maps

Importing and exporting maps between Quattro Pro and Microsoft Excel is not supported.
Map source data is retained, but the map chart is deleted.
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® ®Moving Between Microsoft  PowerPoint  
™and Presentations

Opening Microsoft PowerPoint documents

You can open the following Microsoft PowerPoint file formats in Presentations:

® ®• Microsoft  PowerPoint  2.0

• Microsoft PowerPoint 3.0

• Microsoft PowerPoint 4.0

®• Microsoft PowerPoint 7.0 (Microsoft  Office 95)

• Microsoft PowerPoint 97

To open a Microsoft PowerPoint document: 

1. Click File4Open.

2. Choose the drive and folder where the file is stored.

3. Select Microsoft PowerPoint from the File Type drop down menu.

4. Click a filename.

5. Click Open.

The goal of converting files is to create a document in Presentations that looks and 

functions as it did in Microsoft PowerPoint. Unfortunately, it is not always possible to 

create an identical document.

26WordPerfect Office 11

w h i t e  p a p e r



NOTES: There are some Microsoft PowerPoint features that 

are not supported during the conversion to Presentations: 

Multimedia and animation

• Sound is not supported

• Object animation is not supported

• Movies and animated GIFs are not supported

Text

• Text shadows are converted to normal text

• Emboss effects on text are converted to normal text

Lines

• Line endcaps, such as arrowheads, are not supported

Data charts

• Bubble charts are not supported

OLE Objects

• OLE objects are not supported

Organization charts

• Organization charts are imported as graphic objects

Slides

• Go to keys are not supported

• Skipped slides are not supported
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Saving Presentations documents as 
Microsoft PowerPoint documents 

Ensure that your Presentations files will transfer to different versions of Microsoft 

PowerPoint. 

You can save your Presentations files to the following file formats:

• Microsoft PowerPoint 95 presentation (PR 9, 10 and 11GM)

• Microsoft PowerPoint 97 presentation (PR 9, 10 and 11)

• Microsoft PowerPoint 97/2000/XP presentation (PR 11 SP1)

To save a Presentations document as a Microsoft PowerPoint document: 

1. Click File 4 Save as.

2. Choose the drive and the folder where you want to save the file.

3. Select the Microsoft PowerPoint version from the File Type drop down menu.

4. Type the filename in the Filename list box.

5. Choose a version of Microsoft PowerPoint from the File Type list box.

6. Click Save.

The goal of converting files is to create a document in Microsoft PowerPoint that looks and 

functions as it did in Presentations. Unfortunately, it is not always possible to create an 

identical document.

NOTE: There are some Presentations features that are not 

supported during the conversion to Microsoft PowerPoint:

Text

• Text placed on a path will appear incorrectly in Microsoft PowerPoint

• The position and size of chart items, such as titles and legends, may display incorrectly

• Headers and footers are not supported; they will appear as normal text

Lines

• Line endcaps, such as arrowheads, are not supported
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Data charts

• The color of chart items, such as bars and slices, may appear incorrectly as Microsoft 

PowerPoint only allows 56 colors in its chart color table

• Mixed chart types, where each series has a different chart type, will appear as a single 

chart type

• Chart bar types, such as cone and markers, are not supported

• If you create XY 100% charts, they may not appear correctly

Slides

• Go to keys are not supported

• Action settings, such as Advance slide on mouse click, are not supported

• Slide transitions are not supported

• Custom Audiences are not supported

• Skipped slides are not supported

Objects

• Animation effects added to graphic objects are not supported

• Hyperlinks are not supported

• OLE objects are not supported

• Microsoft PowerPoint color indexed template objects are not supported

Organization charts

• Organization charts are exported as graphics

Multimedia and animation

• Sound is not supported

• Object animation is not supported

• Movies and animated GIFs are not supported
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Comparing Presentations and Microsoft 
PowerPoint menu features 

The following table lists the Edit menu features in Microsoft PowerPoint and the equivalent 

Presentations Edit menu features.

 

® ® ™Microsoft  PowerPoint  97 feature Presentations  feature

Edit  Undo Edit  Undo

Edit  Repeat Edit  Redo

Edit  Cut Edit  Cut

Edit  Copy Edit  Copy

Edit  Paste Edit  Paste

Edit  Paste special Edit  Paste special

Edit  Clear Edit  Clear

Edit  Select all Edit  Select  All

Edit  Delete slide Edit  Delete slide(s)

Edit  Find Edit  Find and replace

Edit  Replace Edit  Find and replace

Edit  Links Edit  Links
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Microsoft PowerPoint and Presentations
File menu features

The following table lists the File menu features found in Microsoft PowerPoint and the 

equivalent Presentations File menu features.

 

Microsoft PowerPoint 97 feature Presentations feature

File  New File  New

File  Open File  Open

File  Close File  Close

File  Save File  Save

File  Save as File  Save as

File  Save as HTML File  Internet Publisher

File  Pack and go File  Show On The Go

File  Page setup File  Page setup

File  Page setup  Slides sized for File  Page setup

File  Page setup  Slides sized for  Letter File  Page setup  Letter

File  Page setup  Slides sized for  A4 File  Page setup  A4

File  Page setup  Slides sized for  Custom File  Page setup  Add new form

File  Page setup  Width File  Page setup  Margins  Left Right

File  Page setup  Height File  Page setup  Margins  Top Bottom

File  Page setup  Orientation File  Page setup  Margins

File  Page setup  Orientation File  Page setup  Portrait

File  Page setup  Orientation File  Page setup  Landscape

File  Print File  Print

File  Send to File  Send to

File  Properties File  Properties

File  Exit File  Exit
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Microsoft PowerPoint and Presentations 
Format menu features

The following table lists the Format menu features in Microsoft PowerPoint and the 

equivalent Presentations Format menu features.

 

Microsoft PowerPoint 97 feature Presentations feature

Format  Font Format  Font

Format  Font List of installed fonts Format  Font Face

Format  Font Effects Format  Font Appearance

Format  Font Effects  Underline Format  Font Appearance  Underline

Format  Font Effects  Shadow Format  Font  Shadow tab

Format  Font  Font style  Bold Format  Font  Appearance  Bold

Format  Font  Font style  Italic Format  Font  Appearance  Italic

Format  Font  Font style  Bold italic Format  Font  Appearance  Bold/italic

Format  Font  Size Format  Font  Size

Format  Font  Size  Available font sizes Format  Font  Size

Format  Font  Color  More colors Format  Font  Color  More

Format  Bullet Format  Bulleted list properties  Bullets  Bullet shape

Format  Bullet  Color Format  Bulleted list properties  Bullets  Color

Format  Bullet  Color  More colors Format  Bulleted list properties  Bullets  Color  More

Format  Bullet  Size Format  Bulleted list properties  Bullets  Relative size

Format  Alignment Format  Justification

Format  Alignment  Right Format  Justification  Right

Format  Alignment  Left Format  Justification  Left

Format  Alignment  Center Format  Justification  Center

Format  Alignment  Justify Format  Justification  Auto

Format  Line spacing Format  Line  Spacing

Format  Line spacing  Line spacing Format  Line  Spacing
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Microsoft PowerPoint 97 feature Presentations feature

Format  Slide layout Format  Layout Gallery

Format  Slide layout  Title slide Format  Layout Gallery  Title

Format  Slide layout  Bulleted list Format  Layout Gallery  Bulleted list

Format  Slide layout  Chart and text Format  Layout Gallery  Combination

Format  Slide layout  Organization chart Format  Layout Gallery  Organization chart

Format  Slide layout  Chart Format  Layout Gallery  Data chart

Format  Slide layout  Blank Format  Layout Gallery  None

Format  Background Format  Background Gallery

Format  Apply design Format  Master Gallery

Format  Apply design  Available PowerPoint designs Format  Master Gallery

Format  Color and lines Format  Object properties

Format  Color and lines  Fill  Color Format  Object properties  Fill

Format  Color and lines  Line  Color Format  Object properties  Line  Color

Format  Color and lines  Line  Dashed Format  Object properties  Line  Style

Format  Color and lines  Line  Style Format  Object properties  Line  Width

Format  Color and lines  Line  Weight Format  Object properties  Line  Width

Format  Color and lines  Arrows  Begin Format  Object properties  Line  Starting cap

Format  Color and lines  Arrows  End Format  Object properties  Line  Ending cap

Format  AutoShape Edit  Arrange

Format  AutoShape  Size  Size and rotate  Rotation Edit  Arrange  Rotate

Format  Picture  Image control  Color Tools  Image tools

Format  Picture  Image control  Color  Grayscale Tools  Image tools  Gray scale

Format  Picture  Image control  Color  Black and white Tools  Image tools  Black and white

Format  Picture  Image control  Color  Watermark Tools  Image tools  Watermark    

Format  Picture  Image control  Color  Brightness Tools  Image tools  Brightness

Format  Picture  Image control  Color Contrast Tools  Image tools  Contrast
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Microsoft PowerPoint and Presentations 
Insert menu features

The following table lists the Insert menu features in Microsoft PowerPoint and the 

equivalent Presentations Insert menu features.

 

Microsoft PowerPoint 97 feature Presentations feature

Insert  New slide Insert  New slide

Insert  New slide  Title slide Insert  New slide  Title

Insert  New slide  Bulleted list Insert  New slide  Bulleted list

Insert  New slide  Text and chart Insert  New slide  Combination

Insert  New slide  Chart and text Insert  New slide  Combination

Insert  New slide  Organization chart Insert  New slide  Organization chart

Insert  New slide  Chart Insert  New slide  Data chart

Insert  New slide  Blank Insert  New slide  None

Insert  Date and time Insert  Date/time

Insert  Date and time  Week day Insert  Date/time

Insert  Date and time  Day  Month  Year Insert  Date/time

Insert  Date and time  Month  Day  Year Insert  Date/time

Insert  Date and time  Time: seconds Insert  Date/time

Insert  Date and time  Update automatically Insert  Date/time  Keep the inserted date current

(insert as field)

Insert  Tab Format  Paragraph  Indent

Insert  Symbol Insert  Symbol

Insert  Comment Insert  Comment

Insert  Slide from outline Insert  File

Insert  Picture Insert  Graphics

Insert  Picture  Clipart Insert  Graphics  Clipart

Insert  Picture  Clipart  Clipart Insert  Graphics  Clipart  Clipart

Insert  Picture  Clipart  Pictures Insert  Graphics  Clipart  Photos
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Microsoft PowerPoint 97 feature Presentations featureInsert  Graphics  Clipart Insert  

Insert  Picture  Clipart  Sounds Insert  Graphics  Clipart  Sounds

Insert  Picture  Clipart  Videos Insert  Graphics  Clipart  Movies

Insert  Picture  From file Insert  Graphics  From file

Insert  Picture  Auto shapes Insert  Shape

Insert  Picture  Organization chart Insert  Organization chart

Insert  Picture  WordArt Insert  Graphics  TextArt

Insert  Picture  From scanner Insert  Graphics  Acquire image

Insert  Text box Insert  Text box

Insert  Movies and sounds Insert  Movies

Insert  Sounds

Insert  Movies and sounds  Movie from gallery Insert  Graphics  Clipart  Movie

Insert  Movies and sounds  Movie from file Insert  Movie

Insert  Movies and sounds  Sound from gallery Insert  Graphics  Clipart  Sounds

Insert  Movies and sounds  Sound from file Insert  Sound

Insert  Movies and sounds  Play CD audio track Insert  Sound  CD

Insert  Movies and sounds  Record sound Insert  Sound  Record

Insert  Chart Insert  Data chart

Insert  Object Insert  Object

Insert  Object  Object type Insert  Object  Object type

Insert  Object  Object type all registered programs Insert  Object  Object type

Insert  Hyperlink Format  Object properties  Speedlink

Insert  Hyperlink  Link to file or URL Format  Object properties  Action  Browse Internet
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Microsoft PowerPoint and Presentations 
Slide show menu features

The following table lists the Slide show menu features in Microsoft PowerPoint and the 

equivalent Presentations Slide show menu features.

 

Microsoft PowerPoint 97 feature Presentations feature

Slide show  View show View  Play slide show

Slide show  Set up show  Show type  View  Play slide show  Repeat slide 

Loop continuously until ESC show until you press ESC

Slide show  Set up show  Slides  Custom show View  Play slide show  Audience

Slide show  Set up show  Advance slides  Manually Format  Slide properties  Display sequence  Manually

Slide show  Set up show  Advance slides  Format  Slide properties  Display 

Using timings  If present sequence after a delay of _ seconds

Slide show  Action buttons Insert shape  Action shapes

Slide show  Action buttons  Custom Insert  Shape  Action shapes  Custom

Slide show  Action buttons  Home Insert  Shape  Action shapes  Home

Slide show  Action buttons  Help Insert  Shape  Action shapes  Help

Slide show  Action buttons  Information Insert  Shape  Action shapes  Information

Slide show  Action buttons  Back of previous Insert  Shape  Action shapes  Back

Slide show  Action buttons  Forward of next Insert  Shape  Action shapes  Forward

Slide show  Action buttons  Beginning Insert  Shape  Action shapes  Beginning

Slide show  Action buttons  End Insert  Shape  Action shapes  End

Slide show  Action buttons  Return Insert  Shape  Action shapes  Return

Slide show  Action buttons  Document Insert  Shape  Action shapes  Document

Slide show  Action buttons  Sound Insert  Shape  Action shapes  Sound

Slide show  Action buttons  Movie Insert  Shape  Action shapes  Movie

Slide show  Action settings... Format  Object properties  SpeedLink

Slide show  Action settings  Mouse click  Format  Object properties  SpeedLink  

Action on click  None Link assignment  Unassigned
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Microsoft PowerPoint 97 feature Presentations feature

Slide show  Action settings  Mouse click  Format  Object properties  SpeedLink 

Action on click  Hyperlink to Link assignment  Go to

Slide show  Action settings  Mouse click  Format  Object properties  SpeedLink 

Action on click  Run program Link assignment  Action  Launch program

Slide show  Action settings  Mouse click  Format  Object properties  SpeedLink  

Action on click  Play sound Link assignment  Action  Play sound

Slide show  Preset animation Format  Object properties  Object animation

Slide show  Preset animation  Off Format  Object properties  

Object animation  Effects  None

Slide show  Preset animation  Drive-in Format  Object properties  Object animation 

Animate object across screen  Fly in  Right to left

Slide show  Preset animation  Flying Format  Object properties  Object animation

 Animate object across screen  Fly in  Left to right

Slide show  Preset animation  Camera Format  Object properties  Object animation

  Animate object in place  Effects  Photo lens out

Slide show  Preset animation  Drop in Format  Object properties  Object animation 

Animate object across screen  Fly in  Top to bottom

Slide show  Preset animation  Fly from top Format  Object properties  Object animation 

Animate object across screen  Fly in  Top to bottom

Slide show  Preset animation  Wipe right Format  Object properties  Object animation 

Animate object in place  Sweep  Left to right

Slide show  Preset animation  Dissolve Format  Object properties  Object animation 

Animate object in place  Dissolve

Slide show  Preset animation  Split vertical out Format  Object properties  Object animation 

Animate object in place  Sweep open

Slide show  Preset animation  Appear Format  Object properties  Object animation 

Animate object in place  Immediate

Slide show  Slide transition Format  Slide properties  Transition
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Microsoft PowerPoint 97 feature Presentations feature

Slide show  Slide transition  Effect  Format  Slide Properties  Transition  Effects

Blinds horizontal Blinds  Direction  Horizontal

Slide show  Slide transition  Effect  Blinds vertical Format  Slide properties  Transition  Effects  

Blinds  Direction  Vertical

Slide show  Slide transition  Effect  Box in Format  Slide properties  Transition  Effects  

Stretch to center

Slide show  Slide transition  Effect  Box out Format  Slide properties  Transition  Effects  

Stretch from center

Slide show  Slide transition  Effect  Cover down Format  Slide properties  Transition  Effects  

Push away  Direction  Top to bottom

Slide show  Slide transition  Effect  Cover left Format  Slide properties  Transition  Effects  

Push away  Direction  Right to left

Slide show  Slide transition  Effect  Cover right Format  Slide properties  Transition  Effects  

Push away  Direction  Left to right

Slide show  Slide transition  Effect  Cover up Format  Slide properties  Transition  Effects  

Push away  Direction  Bottom to top

Slide show  Slide transition  Effect  Cover left-down Format  Slide properties  Transition  Effects  

Push away  Direction  Left and down

Slide show  Slide transition  Effect  Cover left-up Format  Slide properties  Transition  Effects  

Push away  Direction  Left and up

Slide show  Slide transition  Effect  Cover right-down Format  Slide properties  Transition  Effects  

Push away  Direction  Right and down

Slide show  Slide transition  Effect  Cover right-up Format  Slide properties  Transition  Effects  

Push away  Direction  Right and up

Slide show  Slide transition  Effect  Cut Format  Slide properties  Transition  Effects  Immediate

Slide show  Slide transition  Effect  Dissolve Format  Slide properties  Transition  Effects  Dissolve

Slide show  Slide transition  Effect  Fade through black Format  Slide properties  Transition  Effects  Fade

Slide show  Slide transition  Effect  Split horizontal in Format  Slide properties  Transition  Effects  

Slide in close  Direction  Horizontal
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Microsoft PowerPoint 97 feature Presentations feature

Slide show  Slide transition  Effect  Split horizontal out Format  Slide properties  Transition  Effects  

Slide out open  Direction  Horizontal

Slide show  Slide transition  Effect  Split vertical in Format  Slide properties  Transition  Effects  

Slide in close  Direction  Vertical

Slide show  Slide transition  Effect  Split vertical out Format  Slide properties  Transition  Effects  

Slide out open  Direction  Vertical

Slide show  Slide transition  Effect  Wipe down Format  Slide properties  Transition  Effects  

Slide in  Direction  Top to bottom

Slide show  Slide transition  Effect  Wipe left Format  Slide properties  Transition  Effects  

Slide in  Direction  Right to left

Slide show  Slide transition  Effect  Wipe right Format  Slide properties  Transition  Effects  

Slide in  Direction  Left to right

Slide show  Slide transition  Effect  Wipe up Format  Slide properties  Transition  Effects  

Slide in  Direction  Bottom to top

Slide show  Slide transition  Sound  Other sound... Format  Slide properties  Sound

Slide show  Hide slide Format  Slide properties  Do not include this slide (skip)

Slide show  Custom shows Tools  Custom audiences
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Microsoft PowerPoint and Presentations 
Tool menu features

The following table lists the Tool menu features in Microsoft PowerPoint and the 

equivalent Presentations Tool menu features.

 

Microsoft PowerPoint 97 feature Presentations feature

Tools  Spelling Tools  Spell Checker

Tools  Spelling  Change to Tools  Spell Checker  Replace with

Tools  Style checker Tools  Grammatik

Tools  Style checker  Check for  Spelling Tools  Grammatik, Options  Checking styles  

Spelling Plus

Tools  Style checker  Check for  Visual clarity Tools  Grammatik  Options  Analysis and readability

Tools  Style checker  Check for  Visual clarity  Legibility Tools  Grammatik  Options  Analysis  Readability

Tools  Language Tools  Grammatik  Options  Language

Tools  Language  Mark selected text as Tools  Grammatik  Options  Language  Language

Tools  AutoCorrect Tools  QuickCorrect

Tools  AutoCorrect  Correct two initial capitals Tools  QuickCorrect  Options  

Correct two irregular capitals

Tools  AutoCorrect  Capitalize first letter of sentence Tools  QuickCorrect  Format As-You-Go  

Capitalize next letter after end-of-sentence punctuation

Tools  AutoCorrect  Replace text as you type Tools  QuickCorrect

Tools  AutoCorrect  Replace text as you type  Replace Tools  QuickCorrect  Replace

Tools  AutoCorrect  Replace text as you type  With Tools  QuickCorrect  With

Tools  AutoClipArt Insert  Graphics  Clipart

Tools  Macro Tools  Macro

Tools  Macro  Macros Tools  Macro  Play

Tools  Macro  Record new macro Tools  Macro  Record

Tools  Customize Tools  Settings  Customize

Tools  Customize  Toolbars Tools  Settings  Customize  Toolbars
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Microsoft PowerPoint 97 feature Presentations feature

Tools  Customize  Commands Tools  Settings  Customize  Menus

Tools  Customize  Commands  File Tools  Settings  Customize  Menus  Edit

Tools  Customize  Commands  Edit Tools  Settings  Customize  Menus  Edit

Tools  Customize  Commands  View Tools  Settings  Customize  Menus  Edit

Tools  Customize  Commands  Insert Tools  Settings  Customize  Menus  Edit

Tools  Customize  Commands  Format Tools  Settings  Customize  Menus  Edit

Tools  Customize  Commands  Tools Tools  Settings  Customize  Menus  Edit

Tools  Customize  Commands  Windows Help Tools  Settings  Customize  Menus  Edit

Tools  Customize  Options Tools  Settings  Display

Tools  Customize  Options  Show screen tips Tools  Settings  Display  Quicktips

Tools  Options Tools  Settings  Display

Tools  Options  View Tools  Settings  Environment

Tools  Options  View  Show  Startup dialog Tools  Settings  Environment  Startup options

Display document selection (New...) dialog box

Tools  Options  View  Show  New slide dialog Tools  Settings  Environment  Startup options 

Display document

Tools  Options  General  User Information  Name File  Properties  Author

Tools  Options  Edit  Text  Replace straight quotes Tools  Quick Correct  Select quotation marks

Tools  Options  Print File  Print

Tools  Options  Print  Printing Options  File  Print  Advanced  Print text as graphics

Print TrueType fonts as graphics

Tools  Options  Print  Options for current document File  Print  Print range  Slides

only  Use the following default printer settings  

Print what  Slides

Tools  Options  Print  Options for current document File  Print  Print range  Handouts

only  Use the following default printer settings  

Print what  Handouts

Tools  Options  Print  Options for current File  Print  Print range  Speaker notes

document only

Use the following default printer settings  File  Print  Print range  Audience notes

Print what  Notes page
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Microsoft PowerPoint 97 feature Presentations feature

Tools  Options  Print  Options for current document File  Print  Advanced  Adjust image to print 

only  Use the following default printer settings  black and white

Print what  Black and white

Tools  Options  Print  Options for current document File  Print  Layout  Fit to output page

only  Use the following default printer settings  

Print what  Scale to fit paper

Tools  Options  Save File  Settings  Files

Tools  Options  Save  Save options  File  Save  Advanced  Content search criteria

Fill text search information Match all word forms

Tools  Options  Save  Save Options  Save Tools  Settings  Files  Backup  Timed document 

AutoRecover info every _ minutes backup every _ minutes

Tools  Options  Save  Save options  Save PowerPoint File  Save as  File type  PowerPoint

files as  Microsoft PowerPoint 97 Presentation

Tools  Options  Save  Save options  Save PowerPoint File  Save as  File type  PowerPoint

files as  Microsoft PowerPoint 95 and 97 Presentation

Tools  Options  Save  Save options  Save PowerPoint File  Save as  File type  PowerPoint

files as  Microsoft PowerPoint 95 Presentation

Tools  Options  Advanced  File locations  Tools  Settings  Files  Slide show/drawings

Default file location document folder
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Microsoft PowerPoint and Presentations 
View menu features

The following table lists the View menu features in Microsoft PowerPoint and the 

equivalent Presentations View menu features.

 

Microsoft PowerPoint 97 feature Presentations feature

View  Slide View  Slide Editor

View  Outline View  Slide Outliner

View  Slide Sorter View  Slide Sorter

View  Slide show View  Play slide show

View  Master  Notes master Format  Slide properties  Speaker notes

View  Speaker notes Format  Slide properties  Speaker notes

View  Toolbars View  Toolbars

View  Toolbars  Standard View  Toolbars  Toolbar

View  Toolbars  Customize Tools  Settings  Customize

View  Ruler View  Ruler

View  Guides View  Grid/guides/snap  Display guides

View  Header and footer  Slide  Tools  Macro  Play  headfoot.wcm (PR 7, 8 & 9)

Include on slide  Date and time View  Layout Layer  Insert  Footer (PR 10 & 11)

View  Zoom View  Zoom

View  Zoom  Zoom to  Fit View  Zoom  Full page

View  Zoom  Zoom to  400% View  Zoom  Other

View  Zoom  Zoom to  200% View  Zoom  200%

View  Zoom  Zoom to  100% View  Zoom  100%

View  Zoom  Zoom to  66% View  Zoom  Other

View  Zoom  Zoom to  50% View  Zoom  50%

View  Zoom  Zoom to  33% View  Zoom  Other

View  Zoom  Zoom to  Percent View  Zoom  Other
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Using Microsoft PowerPoint shortcut 
keys in Presentations

Keyboard shortcuts for controlling slide shows

The following table lists the Microsoft PowerPoint keyboard shortcuts for slide show 

controls and the equivalent Presentations keyboard shortcuts.

Microsoft PowerPoint 97 What it does Presentations keyboard

keyboard shortcut shortcut

Enter or Spacebar Advances to the next slide Enter or Spacebar

P or Backspace Returns to the previous slide Page up

<number> + Enter Goes to slide <number> Ctrl + G

Esc Ends a slide show Esc

E Erases on-screen annotations Ctrl + E

Keyboard shortcuts for deleting and copying text

The following table lists the Presentations keyboard shortcuts for deleting and copying text 

and the equivalent Microsoft PowerPoint keyboard shortcuts.

Microsoft PowerPoint 97 What it does Presentations keyboard

keyboard shortcut shortcut

Backspace Deletes one character to the left Backspace

Ctrl + Backspace Deletes one word to the left Ctrl + Backspace

Delete Deletes one character to the right Delete

Ctrl + Delete Deletes one word to the right Ctrl + Delete

Ctrl + X Moves the object to the Clipboard Ctrl + X

Ctrl + C Copies the selected object Ctrl + C

Ctrl + V Inserts object from the Clipboard Ctrl + V

Ctrl + Z Undoes the last action Ctrl + Z
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Keyboard shortcuts for moving around in text

The following table lists the Microsoft PowerPoint keyboard shortcuts for moving around 

in text and the equivalent Presentations keyboard shortcuts.

Microsoft PowerPoint 97 What it does Presentations keyboard

keyboard shortcut shortcut

Left arrow key Moves one character to the left Left arrow key

Right arrow key Moves one character to the right Right arrow key

Up arrow key Moves one line up Up arrow key

Down arrow key Moves one line down Down arrow key

Ctrl + Left arrow key Moves one word to the left Ctrl + Left arrow key

Ctrl + Right arrow key Moves one word to the right Ctrl + Right arrow key

End Moves to the end of a line End

Home Moves to the beginning of a line Home

Ctrl + End Moves to the end of a text box Ctrl + End

Ctrl + Home Moves to the beginning of a text box Ctrl + Home
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Keyboard shortcuts for selecting text and objects

The following table lists the Microsoft PowerPoint keyboard shortcuts for selecting text 

and objects and the equivalent Presentations keyboard shortcuts.

Microsoft PowerPoint 97 What it does Presentations keyboard

keyboard shortcut shortcut

Shift + Right arrow key Selects one character to the right Shift + Right arrow key

Shift + Left arrow key Selects one character to the left Shift + Left arrow key

Ctrl + Shift + Right arrow key Selects to the end of a word Ctrl + Shift + Right arrow key

Ctrl + Shift + Left arrow key Selects to the beginning of a word Ctrl + Shift + Left arrow key

Ctrl + A Selects all objects Ctrl + A

Microsoft PowerPoint 97 What it does Presentations keyboard

keyboard shortcut shortcut

Ctrl + Tab Moves to the next tab in a dialog box Ctrl + Tab

Ctrl + Shift + Tab Switches to the previous tab in a Ctrl + Shift + Tab

dialog box

Tab Moves to the next option in a Tab

dialog box

Shift + Tab Moves to the previous option or Shift + Tab

option group

Alt + Down arrow key Opens a selected list box Alt + Down arrow key

Esc Closes a selected list box Esc

Keyboard shortcuts for working in dialog boxes

The following table lists the Microsoft PowerPoint keyboard shortcuts for working in 

dialog boxes and the equivalent Presentations keyboard shortcuts.
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Customizing Presentations

One of the key strengths of Presentations is its ease of customization. You can customize 

virtually any element of Presentations to reflect your preferred working environment.  

To customize Presentations 11: 

1. Click Tools 4 Settings.

Customizing toolbars 

For quick access to the commands, tools and features you use most often, create your own 

toolbars. Edit toolbars by adding and removing buttons and separators, and by adding 

keystrokes. For example, if you type a particular word often, assign the word to a toolbar 

button, then click the button every time you need to insert that word. As well, you can add 

buttons that let you start programs, open files and run macros. Change the location of custom 

toolbars in the application window, as well as the appearance of toolbar buttons; copy 

toolbars; and rename custom toolbars. When you no longer need a custom toolbar, delete it.

Customizing the Property Bar 

For quick access to the commands, tools and features you use most often in the Property 

Bar, edit its configurations by adding and removing buttons and separators, and by adding 

keystrokes. You can also add programs, files and macros to the Property Bar. For example, 

if you use a particular program often, assign it to a Property Bar button, then click the 

button whenever you need to start the program. To return the Property Bar to its original 

configuration, reset it. In addition, you can change the location of the Property Bar as well 

as the appearance of its buttons.

Customizing tool palettes 

For quick access to the commands, tools and features you use most often, customize your 

tool palettes. Edit tool palettes by adding and removing buttons and separators, and by 

adding keystrokes. For example, if you use a particular function often, assign it to a tool 

palette button, then click the button every time you need to use the function. You can also 

add buttons that let you start programs, open files and run macros. After you edit a tool 

palette, reset the default settings. Plus, change the location of a tool palette in the 

application window and change the appearance of tool palettes.
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Customizing keyboard shortcuts 

Shortcuts provide a faster way to perform tasks. Before you assign new shortcuts, you must 

create the keyboards under which you’ll organize them. Keyboards are sets of shortcut 

preferences you can create to meet the needs of various projects and users. After you create a 

keyboard, copy and rename it. When you no longer need a custom keyboard, simply delete it.

Assign shortcuts to features, keystrokes, programs, macros, symbols and special characters. 

For example, assign a shortcut to a symbol then press the shortcut whenever you need to 

use the symbol. You can also choose to display a shortcut on a menu. Plus, remove an 

assignment you made to a shortcut, export a keyboard shortcut to a file and print a 

keyboard shortcut report.

Customizing the Menu Bar 

Create multiple configurations of the Menu Bar to get quick access to the commands, tools 

and features you use most often. Edit Menu Bar configurations by adding and removing 

menu items and separators, and by adding pull-down menus and keystrokes. Add 

programs, files and macros to the Menu Bar by creating buttons that represent them. Plus, 

copy and rename Menu Bar configurations. When you no longer need a Menu Bar 

configuration, delete it.

Setting up display features 

Display a variety of menu features in your work environment. For example, show hints 

with menu items and set the units of measure used in Presentations, i.e., change the ruler’s 

unit of measure.

Customizing environment settings 

Change the startup setting in Presentations. For example, choose what type of project 

opens when you start Presentations. When creating a new slide show, choose to have the 

Master Gallery display automatically. You can also specify the environment options by 

using enhanced file dialog boxes; changing the text-dragging functionality; automatically 

converting graphics that are in Windows Metafile format (WMF) into the WordPerfect 

Graphic file format (WPG) when importing them into your slide show; changing default 

drawing settings; and indicating search failure. If you have a language module installed, 

you can also specify which environment language you want to use. Choose the language of 

the text that appears in the Presentations application window—including dialog box text, 

prompts and the Menu Bar—and choose the writing tools language.
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Customizing the location of slide show, drawing and multimedia files 

Specify the default folders for the following types of files: slide shows, masters, 

backgrounds, macros and toolbars. Plus, set the default folders for the following types of 

multimedia files: sound clips, textures, pictures and movies. You can also create a folder in 

which backup files for slide shows, drawings and multimedia files are stored. Choose to 

save the backup file at timed intervals and create a backup of a file each time you save it.

Publishing to PDF in Presentations 

Publishing a slide show as an electronic document in Portable Document Format (PDF) 

preserves the typography, images, graphics, color and formatting of the original publication. 

PDF also allows you flexibility to specify text formatting, color model and compression 
®options. PDF files are platform-independent and can be edited by Windows and Macintosh  

® ®users with Adobe  Acrobat  Writer, and they can be viewed, shared and printed using 
® ® ®Adobe  Acrobat  Reader . 

1. Click File > Publish to PDF.

2. Click the General tab.

3. Type a file path and filename in the Filename box.

4. In the Export range area, enable one of the following options:

• Full document

• Current view

• Selection

• Slides (type a number in the box beside it)

• Speakers notes (type a number in the box beside it)

• Audience notes (type a number in the box beside it)

• Handouts and (type a number in the box beside it)

5. Choose a compatible PDF application from the Compatibility list box.

6. Type the author’s name in the Author box.

7. Type any keywords in the Keywords box.

8. Choose a PDF style from the PDF style list box.
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09/93 3226-57

For more information, please visit 
www.wordperfect.com

Contact Information

www.corel.com/media

Web site: www.corel.com

General telephone: 1-613-728-8200 ext. 1801

Reader contact information: 1-800-77-COREL

Fax: 1-613-728-9790

Media inquiries: media@corel.com
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